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About This Guide

This guide contains installation and licensing information for Arbortext Editor,
Arbortext Styler, Arbortext Architect, and the following product options:

* Arbortext Print Composer option

» Arbortext Web/Wireless Composer option

* Arbortext Import/Export

* PTC Server connection

» Arbortext Adapter to Documentum/XML

» Arbortext Adapter to Documentum/WDK

» Arbortext Adapter to Documentum

» Arbortext Adapter to Oracle CM SDK

* Arbortext Adapter to IBM Document Manager
Note

See the Arbortext Editor, Styler, and Architect Release Notes for updated
information about the Arbortext product lines and product options.

Prerequisite Knowledge

This guide is intended for systems administrators. It is assumed that you are
familiar with the operating system at your site and with standard system
administration tasks.

Related Documentation

For more information refer to the Arbortext Editor Help Center.



Technical Support

Contact PTC Technical Support using the PTC Web site, phone, fax, or e-mail if
you encounter problems using your product or the product documentation.

For complete information, refer to Contacting Technical Support in the PTC
Customer Service Guide. This guide can be found on the PTC Web site at:

http://www.ptc.com/support/

The PTC Web site also provides a search facility for technical documentation of
particular interest. To access this search facility, use the URL above and select
Search the Knowledge Base.

You must have a Service Contract Number (SCN) before you can receive technical
support. If you do not have an SCN, contact PTC Maintenance Department using
the instructions found in your PTC Customer Service Guide under Contacting
Your Maintenance Support Representative.

Documentation for PTC Products

You can access PTC product documentation using the following resources:
*  Online Help

Click Help from the user interface for online help available for the product.
* Reference Documents

Individual product manuals are available from the Reference Documents link
of the PTC Web site at the following URL:

http://www.ptc.com/support/
» Help Center

A searchable product documentation knowledge base is available from the
Help Center link of the PTC Web site at the following URL:

http://www.ptc.com/support/

You must have a Service Contract Number (SCN) before you can access the
Reference Documents or Help Center Web site. If you do not have an SCN, contact
PTC Maintenance Department using the instructions found in your PTC Customer
Service Guide under Contacting Your Maintenance Support Representative.

Global Services

PTC Global Services delivers the highest quality, most efficient and most
comprehensive deployments of the PTC Product Development System including
Pro/ENGINEER, Windchill, Arbortext and Mathcad. PTC’s Implementation and
Expansion solutions integrate the process consulting, technology implementation,
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education and value management activities customers need to be successful.
Customers are led through Solution Design, Solution Development and Solution
Deployment phases with the continuous driving objective of maximizing value
from their investment.

Contact your PTC sales representative for more information on Global Services.

Comments

PTC welcomes your suggestions and comments on our documentation. You can
submit your feedback to the following email address:

arbortext-documentation@ptc.com

Please include the following information in your email:

e Name
* Company
* Product

* Product Release
*  Document or Online Help Topic Title
» Level of Expertise in the Product (Beginning, Intermediate, Advanced)

+ Comments (including page numbers where applicable)

Documentation Conventions

This guide uses the following notational conventions:

* Bold text represents exact text that appears in the program's user interface. This
includes items such as button text, menu selections, and dialog box elements.
For example,

Click OK to begin the operation.
* A right arrow represents successive menu selections. For example,
Choose File » Print to print the document.

* Monospaced text represents code, command names, file paths, or other
text that you would type exactly as described. For example,

At the command line, type version to display version information.

* Ttalicizedmonospaced text represents variable text that you would
type. For example,

installation-dir\custom\scripts\

» Italicized text represents a reference to other published material. For example,

Comments
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If you are new to the product, refer to the Getting Started Guide for basic
interface information.
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Supported Systems and
Requirements

Core Product SUpported SYStEMS .......uiiiiiiiiiiie e 10
Supported Systems for Other Products and Options ...........cccovviiiiiiiiiiiiiie e, 12
Platform Specific REQUIrEMENTS ...... oo e 20
Setting Up Arbortext Editor to Use Arbortext Publishing Engine ............cccooooiiiiis 21

This chapter provides information on the supported platforms and requirements for
Arbortext Editor, Arbortext Styler, Arbortext Architect, and other product options.
It also contains system requirements for supported platforms.



Core Product Supported Systems

This section provides information on supported platforms and requirements for the
basic Arbortext Editor product suite.

Support for Arbortext Editor

The following table lists the supported platforms and versions for Arbortext Editor
6.0.

Arbortext Editor Supported Systems

Windows

XP Vista 7 Server 2003 | Server 2008
X X X X X
X — indicates certification
If you're performing a Windows installation to share with Windows client
installations, install to one of the Windows servers.
Both the 32 and 64-bit versions of Windows are supported.

The CJK language locales (Chinese, Japanese, or Korean) are automatically
enabled for the appropriate corresponding system locale in Arbortext Editor.

Browser Support for Web Preview and Output

The web browser support applies to the Publish HTML File feature and the Publish
For Web output.

Web Browser Support

Browser and version Windows Solaris
XP Vista 7 9 10

Microsoft Internet 8.0 X X X NA NA
Explorer

7.0 X X X NA NA
Mozilla Firefox 3.6* X X X X X
X — indicates certification
NA — not available
*All previous 3.x versions are also supported
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Internet Protocol Version 6 Support
Arbortext Editor supports Internet Protocol Version 6 (IPv6).

Sun's JVM Delivered with Arbortext Editor

The JVM delivered for this release is contained in the Java Runtime Environment.
Several product features rely on the embedded JVM:

* All publishing features that use XSL stylesheets

+ Java AOM/DOM interface, including the Java Console (available from the
Tools menu, or you can use the java console function)

» JavaScript

To see the current Java VM Version included with Arbortext Editor, select Tools »
Administrative Tools » Java Console to open the Arbortext Java Console.

Perl Version for APP Delivered with Arbortext Styler
or Arbortext Publishing Engine

An Arbortext installation that includes Arbortext Styler or Arbortext Publishing
Engine also includes a packaged installation of the APP print engine and
associated support files, plus the Perl release needed to support the APP print
engine functionality. This installation does not require additional licensing. The
installed Perl DLL per158.d11, installed to the directory Arbortext-path
/app/perl/bin, provides Perl release 5.8, which is necessary to support this
installation.

You may prefer to specify the location of an alternative Perl installation to that
supplied with your Arbortext environment. Please use the environment variable
APTAPPPERL to define the path to the root folder of the desired Perl installation.
Note that this directory must contain a \ bin subdirectory containing the Perl
version 5.8 DLL per158.d11.

Note that an installation of Arbortext without Arbortext Styler or Arbortext
Publishing Engine does not include APP.

Arbortext Help Center Requirements

The Arbortext Help Center runs using an embedded browser based on Internet
Explorer. Changes you make to the settings in Internet Explorer, such as text size,
might affect the Help Center as well.
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Requirements for Hosting ActiveX Controls

When running on Windows XP, Vista, or 7, Arbortext Editor can host ActiveX
controls through an underlying Active Script engine. To establish Arbortext Editor
as an Active Script host, you must have the system files jscript.dll,
vbscript.dll and scrrun.dll. These files are typically found in your
system folder, and are likely already installed on your system if you have installed
Internet Explorer 4.0 or higher.

Additionally, to ensure you have the latest updates and capabilities, it is
recommended that you download and install the most recent version of the
Microsoft Windows Script Host. (The current version is 5.8.)

You may also want to download the following applications:

*  Microsoft Script Component Wizard — to create Windows Script Components

* Microsoft Script Debugger — to employ an interactive script debugger

You can download these applications from Microsoft's MSDN:

msdn.microsoft.com

Requirements for Running Arbortext Editor's ActiveX
Sample Applications

You must have the Microsoft Calendar Control installed to properly run the
Calendar sample script. This control is usually installed when you install Microsoft
Access. If you do not have the file MSCAL .OCX installed on your system, you can
download the file from the following URL:

www.fontstuff.com/mailbag/gvball.htm

You must have the Microsoft WebBrowser control installed to enter address
information as part of the HTML form sample. This control resides in SHDOCVW .
DLL, and is installed as part of Internet Explorer 4.0 or higher.

Supported Systems for Other Products
and Options

This section provides information on supported platforms and requirements for
other Arbortext products and product options.

Arbortext Styler

Arbortext Styler is supported on the following systems:

12 Installing Arbortext® Editor™, Styler™, and Architect™


http://www.fontstuff.com/mailbag/qvba01.htm

Arbortext Styler Supported Systems

Windows
XP Vista 7
X X X
X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.
Arbortext Architect
Arbortext Architect is supported on the following systems:
Arbortext Architect Supported Systems
Windows
XP Vista 7
X X X
X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.

Turbo XML for Arbortext Architect

Arbortext Architect can use Turbo XML, a graphical user interface product from
Extensibility, Inc., for editing XML DTDs and schemas. Turbo XML can be
installed separately following your installation of Arbortext Editor.

Note

The Turbo XML product is no longer supported by TIBCO Software, Inc. and is
not officially supported on Microsoft Windows XP, Vista, or 7. Turbo XML should
run on Microsoft Windows XP for users that log on with administrator privileges.
On Windows Vista and 7, you must run Turbo XML in Windows XP compatibility
mode. To set the compatibility mode, view the properties of the Turbo . exe
executable file, select the Compatibility tab on the properties dialog box, and select
Windows XP tfor the Compatibility mode setting.

Turbo XML will continue to be delivered with Arbortext Architect. However, no
Turbo XML issues will be addressed by either TIBCO or PTC.

Arbortext Print Composer Option

The Arbortext Print Composer option is available on the following systems:
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Arbortext Print Composer Option Supported Systems

Windows
XP Vista 7 Server 2003 | Server 2008
X X X X X

X — indicates certification

If this installation of Arbortext Editor will be using Arbortext Publishing Engine to
perform document publishing, Arbortext Print Composer and/or the Arbortext
Web/Wireless Composer product options will also be installed on the Arbortext
Editor client to make the publishing menu choices available. Also, the version of
Arbortext Editor on each workstation must be 5.3 M040 or later to support
Arbortext Publishing Engine 6.0 FOOO on the server.

If you will be using the Arbortext Print Composer option with Adobe Acrobat
Distiller Server to produce PDF or PostScript output, you should set the display
resolution to at least 65K or 16-bit color.

Arbortext Web/Wireless Composer Option

The Arbortext Web/Wireless Composer option is available on all Arbortext Editor
supported platforms and systems. Refer to the table in Browser support for web
preview and output for supported browser versions.

If this installation of Arbortext Editor will be using Arbortext Publishing Engine to
perform document publishing, Arbortext Print Composer and/or the Arbortext
Web/Wireless Composer product options will also be installed on the Arbortext
Editor client to make the publishing menu choices available.

Publishing documents for DMP is available with the Web/Wireless license.
Publishing files for use with DMP does not require that Digital Media Publisher be
installed on your workstation. However, if DMP is not installed on your
workstation and you are not publishing using the Arbortext Publishing Engine, you
will only be able to create files that can be used as input to a DMP image created at
a later time (with DMP). Digital Media Publisher is included with the Arbortext
Publishing Engine.

Arbortext Import/Export

Arbortext Import/Export is available on all Arbortext Editor supported platforms
and systems. Arbortext Import/Export requires the Arbortext Publishing Engine to
import and export documents.
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Arbortext Import/Export Supported Systems

Windows
XP Vista 7
X X X

X — indicates certification

Arbortext Import/Export must be installed and licensed on your Arbortext
Publishing Engine.

Export stylesheet development, Import MapTemplate development, and
document conversion can be performed directly on an Arbortext Publishing
Engine server using Arbortext PE Interactive. The Arbortext Publishing Engine
is also the engine used by client workstations performing document
conversions.

To import and export files (and do no Import MapTemplate or Export
Stylesheet development), each Arbortext Editor workstation must be
configured to use the Arbortext Publishing Engine for publishing.

Ensure that each client workstation has featureImportExport setto on
in their installprefs.acl file and has the following set option values (or
Advanced Preference settings):

O peservices =on

© peserverurl =<your PE server name>

If your workstation is not currently connected to an Arbortext Publishing
Engine server licensed for Arbortext Import/Export, you will not be able to
import or export documents using Arbortext Import/Export.

To develop export stylesheets on Arbortext Editor client workstations,
Arbortext Styler and Arbortext Import/Export must be licensed and installed on
these workstations. Ensure these workstations have the same
installprefs.acl and Advanced Preference settings as those for
workstations used to import and export files.

To develop Import MapTemplates, Microsoft .NET Framework Version 2.0
Redistributable Package (x86) and .NET Compact Framework 2.0 Service
Pack 1 Redistributable (or .NET Version 3.0 which includes the .NET Version
2.0 Framework) must be installed on each Arbortext Editor client workstation
where Arbortext Import/Export will be used.

Arbortext Import/Export must also be installed and licensed on these
workstations. Ensure these workstations have the same installprefs.acl
and Advanced Preference settings as those for workstations used to import and
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export files. Additionally, ensure that featureImportMapping is set to on
in each workstation's installprefs.acl file.

» Arbortext Import does not support importing Hebrew, Arabic, and Thai
content.

Refer to the Arbortext Import/Export chapter of the Arbortext Customizer's Guide
for information on configuring and using Arbortext Import/Export.

Dynamic Link Manager

Dynamic Link Manager clients are available on all Arbortext Editor supported
platforms and systems. Workstations must be running the same release of Dynamic
Link Manager as the Dynamic Link Manager server.

Refer to the Dynamic Link Manager chapter in the Arbortext Customizer's Guide
for complete Dynamic Link Manager platform requirements.

PTC Server connection

The PTC Server connection is available on the following systems for connecting to
the Arbortext Content Manager:

PTC Server connection Supported Systems for the Arbortext Content
Manager

Windows
XP Vista 7
X X

X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.

The PTC Server connection is available on the following systems for connecting to
Windchill PDMLink:

PTC Server connection Supported Systems for Windchill PDMLink

Windows
XP Vista 7
X X X

X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.
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The PTC Server connection is available on the following systems for connecting to
Windchill ProjectLink:

PTC Server connection Supported Systems for Windchill ProjectLink

Windows
XP Vista 7
X X X

X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.

The PTC Server connection is supported for the following PTC content
management systems:

» Arbortext Content Manager 9.1 M060 or later
*  Windchill PDMLink 9.1 M060 or later
*  Windchill ProjectLink 9.1 M060 or later

Internet Protocol Version 6 Support

The PTC Server connection supports Internet Protocol Version 6 (IPv6).

Arbortext Adapter to Documentum/XML

The Arbortext Adapter to Documentum/XML is available on the following
systems:

Arbortext Adapter to Documentum/XML Supported Systems

Windows

XP

X

X — indicates certification

The following table provides the repository requirements for the Arbortext Adapter
to Documentum/XML:

Arbortext Adapter to Documentum/XML Requirements

Documentum Content Server Documentum Desktop Client

6.0 or 6.5 53
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Note

The Arbortext Adapter to Documentum/XML does not support Documentum
Desktop Client 5.3 SP5.5.

Arbortext Adapter to Documentum/WDK

The Arbortext Adapter to Documentum/WDK is available on the following
systems:

Arbortext Adapter to Documentum/WDK Supported Systems

Windows
XP Vista 7
X X X

X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.

The following table provides the repository requirements for the Arbortext Adapter
to Documentum/WDK:

Arbortext Adapter to Documentum/WDK Requirements

Documentum Content Server Documentum Webtop

6.0 or higher 6.0 or 6.5 running on the Apache/
Tomcat Application Server or the Oracle
WebLogic Application Server

We are not aware of any issues with using Federated or Replicated docbases with
the Arbortext Adapter to Documentum/WDK. However, the adapter has not been
certified with Federated or Replicated docbases.

Web Browser Support

The Arbortext Adapter to Documentum/WDK is supported on Microsoft Internet
Explorer 7.0 and 8.0.

Internet Protocol Version 6 Support

The Arbortext Adapter to Documentum/WDK supports Internet Protocol Version 6
(IPv6). Note that IPv6 support requires Documentum Webtop version 6.5 or later.
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Arbortext Adapter to Documentum

The Arbortext Adapter to Documentum is available on the following systems:

Arbortext Adapter to Documentum Supported Systems

Windows

XP

X

X — indicates certification

The following table provides the repository requirements for the Arbortext Adapter
to Documentum:

Documentum Requirements

Documentum Content Server Documentum Desktop Client
6.0 or higher 53

Arbortext Adapter to Oracle CM SDK

The Arbortext Adapter to Oracle CM SDK servlet is installed on the Oracle host,
and is supported on Windows, Solaris, and Linux systems only.

Arbortext Adapter to Oracle CM SDK Client Supported Systems

Windows
XP Vista 7
X X

X — indicates certification
Both the 32 and 64-bit versions of Windows are supported.

The Arbortext Adapter to Oracle CM SDK is supported for the following Oracle
systems:

- CM SDK 10g (9.0.4)
« CMSDK 10.2 (9.0.4.2)
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Arbortext Adapter to IBM Document Manager

The Arbortext Adapter to IBM Document Manager is available on the following
systems:

Arbortext Adapter to IBM Document Manager Supported Systems

Windows

XP Vista

X X

X — indicates certification

The following IBM DB2® Document Manager requirements must be met to install
and use this adapter successfully:

» The repository must be installed and configured on the server.
« IBM DB2 Content Manager must be at an 8.3 Fix Pack 6 or later.
« IBM DB2 Document Manager must be at an 8.3 Fix Pack 6 or later.

Platform Specific Requirements

The following sections provides hardware, system, and other requirement
information.

Windows System Requirements

Any Windows system running Arbortext software must meet the following list of
hardware and software requirements.

Hardware Requirements

If your system can run the associated operating system effectively, then that system
should be able to run your Arbortext software without an issue. Disk space
requirements are approximately 930 MB to 1.1 GB, depending on the product
options included in the installation. The Arbortext installation program displays the
space required for the base program and each of the product options.

Screen Fonts

Arbortext software works best when used with TrueType (TT) or PostScript Type 1
(PS1) fonts. Raster fonts may cause display problems.
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Other Windows Software Requirements

The File » Publish » For HTML Help feature requires the Microsoft HTML Help
Workshop. The Workshop is a free download from:
msdn.microsoft.com/en-us/library/ms669985.aspx

When you install the HTML Help Workshop, you must start and close the
HTML Help Workshop application once before you use the File » Publish » For
HTML Help menu option.

Arbortext Editor is compatible with JAWS accessibility screen reader software
version 5.0 or later. For more information, refer to Arbortext-path

\ samples\ jaws\ Readme. txt.

Note that the JAWS accessibility screen reader does not run on 64-bit versions
of Windows.

Setting Up Arbortext Editor to Use
Arbortext Publishing Engine

You can perform all publishing tasks using Arbortext Publishing Engine in the
same manner you would locally. If your installation of Arbortext Editor will be
using Arbortext Publishing Engine for publishing documents, you will need to
enter some information to connect to it.

The Arbortext Editor installation procedure prompts you for the location of
Arbortext Publishing Engine. If you didn’t have that information at the time of
installation, you will need to set it up in Tools > Preferences » Publishing Engine.

1.

Check the box for Use Publishing Engine.

2. You will need to obtain the URL for your site's Arbortext PE server from your

Arbortext PE administrator. Enter the URL following the form:

http://server-name:port-number/e3/servliet/e3

where server-name is the host name of the server and port-number is the port
that requests should be sent through.

Click the Apply button to test the URL to assure it is correct.

The Status field reports whether the URL successfully connects to an
Arbortext PE server.

If the connection fails, click the Show Connection Error button to display the
error message from the Arbortext PE server. If you re-enter your URL and it
fails again, contact your Arbortext PE administrator and report the error.
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Note

One reason the connection may fail is if Arbortext Editor is running on a
different type of network than Arbortext PE. Both Arbortext Editor and
Arbortext Publishing Engine support IPv4 and IPv6, but they must both be
running on the same type of network to avoid an error. Check with your system
administrator to resolve networking issues.

Be sure to read Using Arbortext Publishing Engine for publishing documents in
the Arbortext Help Center for extensive information about publishing in this
manner.

Local publishing requires that Arbortext Styler, Arbortext Print Composer and/or
the Arbortext Web/Wireless Composer product options are installed on the
Arbortext Editor client to make the publishing menu choices available.

If you need more information about setting up Arbortext Publishing Engine,
consult the Arbortext Publishing Engine documentation or your Arbortext
Publishing Engine administrator.
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This chapter contains tasks you should perform before upgrading Arbortext Editor.
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Pre-Installation Tasks Overview

The following tasks should be performed before you install the new version of
Arbortext Editor.

* Obtain a new license for your upgraded version. Refer to Obtaining Licenses
on page 54 for more information.

After Upgrading from a Previous Version

After you have installed Arbortext Editor successfully, and migrated your
customizations, Post-installation upgrade tasks on page 29 provides detailed
instructions for tasks that must be performed in order for Arbortext Editor to
operate properly.
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This chapter contains information about things you might want to do before
upgrading from a previous version of Arbortext Editor.
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Software Upgrade Considerations

This section contains information that is helpful when you are upgrading from a
previous version of Arbortext Editor. Review it before proceeding with the
installation of your software, particularly if you have any customizations that need
to be migrated to the new version.

Upgrading from a Previous Version
The 6.0 version of Arbortext Editor is a full installation.

» Ifyou are currently running the 5.4 or earlier version of Arbortext Editor, then
the 6.0 version is a new release and cannot upgrade the 5.4 or earlier version. If
you no longer want to have the 5.4 or earlier version on your system, you must
uninstall that version.

* If you will be temporarily running both the 6.0 version of Arbortext Editor and
the 5.4 or earlier version, install the new version in a different directory from
your current version.

* You may have customized files from previous installations located in different
directories. If you want to maintain custom files, you need to save them in a
temporary location for evaluation after you upgrade. For example, you may
have files with specific configuration settings that you will want to use to
update the new configuration files. Be sure to copy your custom files to a
temporary location so they will be available after you upgrade.

If your current Arbortext Editor installation does not include customizations that
need to be migrated to the new version, you can proceed to the installation and
licensing section that is appropriate to your site. After you have successfully
installed the new version, you will need to perform the post-installation upgrade
tasks described in Post-installation upgrade tasks on page 29.

Upgrading on Windows

On Windows, you cannot upgrade from a 5.4 or earlier version to the 6.0 version.
You must do a full installation.

Note

Generally, upgrades can be performed on FO00 and subsequent M0On0 releases.
However, in rare cases it's possible that a MOnx version might be released after the
next M0On0 version. Because releases are cumulative, this upgrade situation would
require installing the next MOnO version rather than an upgrade. For instance, if an
MO020 version is released in April, followed by an M015 release in May, an
upgrade from M015 to M020 would not be possible as it was released after M020.
The next upgrade path would become M030 or later.
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If you choose to uninstall a previous version and then reuse the installation path for
your upgrade and its directories are not empty, you'll be advised to install to
another location.

Migrating Customizations

If your current installation has been customized using environment variables or
custom scripts or applications, you will need to migrate these customizations to
this version of Arbortext Editor. It is recommended that you first install Arbortext
Editor on a test system reflecting your current user environment. It should not have
been previously customized or have the customizations disabled.

If you are upgrading from Arbortext Publishing Engine 4.3 or higher, you may
have placed custom files in the PEHOME\ custom subdirectory structure. The
uninstall feature leaves your custom files in the custom directory intact. You can
reuse the previous install path if you have files in the custom directory. The
upgrade installation only overwrites an existing file having the same name and
path. If you placed custom files in other install tree locations, the upgrade could
overwrite them. If you prefer a clean installation, you can copy the entire directory
and its contents to a backup location. After you complete the upgraded installation,
you can migrate your custom files to the upgraded installation custom directory.

Perform the following procedure on your test system to ensure that all
customizations have been removed or disabled:

1. Check your environment variables for any that relate to Arbortext Editor.

In general, you should check all environment variables you have set up for
your Arbortext Editor environment to make sure they are all relevant and
current. For instance, you could have APTCUSTOM set to a path list that has
changed due to upgrading to your installation.

2. Record the current settings of any Arbortext Editor environment variables, so
that you can reset them appropriately after you have installed the new version.

3. Delete all Arbortext Editor environment variables.

Caution

Once you’ve set the PTC_D LICENSE FILE environment variable, don’t
delete it. This provides access to your licenses. However, the licenses
themselves need to be upgraded. You may need to verify that the upgraded
license file or license server location has not changed.

4. Disable any scripts, applications, or files that may be part of the current
version's customizations.
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You can now install Arbortext Editor on your test system according to the
procedures in the installation and licensing chapters.

After you have successfully installed the new version, you will need to perform the
post-installation upgrade tasks described in Post-installation upgrade tasks on page
29.
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Post-Installation Upgrade Tasks
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This chapter contains tasks you should perform after upgrading Arbortext Editor.
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Post-Installation Task Overview

The following tasks should be performed after you have successfully installed the
new version of Arbortext Editor.

» Copy your customized files to the new custom subdirectory structure on the
test system.

Refer to Using the custom directory on page 30 for more information.

* Setthe writeentdecls command, if necessary.

Refer to Setting the writeentdecls command on page 30 for more information.

» Edit your ACL scripts, if necessary.

Refer to Editing ACL scripts on page 31 for more information.

* Migrate your package customizations.

Refer to Package customizations on page 31 for more information.

* Migrate your tag template customizations.

Refer to Tag template customizations on page 31 for more information.

* Once you have successfully implemented and tested the recommended and
optional customizations, move the new Arbortext Editor installation and its
customizations to your production environment.

Using the Custom Directory

Arbortext Editor provides a custom directory structure within the Arbortext
installation tree where you can store your custom applications. When Arbortext
Editor starts, it automatically looks for files in this directory structure and loads
them. You can place custom files such as Java (. class and . jar), JavaScript (.
js), JScript (. js), VBScript (. vbs), ACL (.acl), and various configuration
files in their supported locations within the Arbortext-path\ custom
subdirectory structure to make them available.

Refer to the Arbortext Programmer's Reference for more information.

Setting the writeentdecls Command

Arbortext Editor includes the set writeentdecls command, which controls
how entity declarations are written in the subsets of the main document and in file
entities. By default, entity declarations are written in the root document's subset,
and only declarations referenced immediately within a child will be written to that
child's subset.

30 Installing Arbortext® Editor™, Styler™, and Architect™



If you wish to change the default setting, we recommend you set the option to be
used site wide, and that you convert all documents and document objects to the
new default by opening and saving them in Arbortext Editor.

Note
Refer to the set writeentdecls online help topic for more information.

Editing ACL Scripts

Changes to the new version of Arbortext Editor may require you to change your

ACL scripts. Check your ACL scripts (. acl) to see if they are affected by the new
or changed ACL commands and functions. The new and changed ACL commands
and functions are listed in the Arbortext Editor, Styler, and Architect Release Notes

Package Customizations

Your previous Arbortext Editor installations might have customizations of files in
the Arbortext-path\ packages directory. Many of the files in the
packages subdirectory change from version to version, so you should compare
the contents of your customized files to the new files.

You might want to add your customized .acl and . js files to the
Arbortext-path\ custom\ scripts subdirectory.

Note

Customizations specific to a document type should be moved to document type
command files (doctype. js or doctype.acl) or document type instance
command files (instance. js or instance.acl) within the custom

\ doctypes\ doctype directory.

Refer to Using the Custom Directory on page 30 for more information.

Tag Template Customizations

If you had custom tag template files in your previous Arbortext Editor installations,
you may want to add a tagtemplates subdirectory to the Arbortext-path
\ custom directory structure, and copy your customized files directly to that
location.

Note

Arbortext Editor will not automatically process tag template customizations.
Instead, you must specify the path to this file using the APTTAGTPLDIR
environment variable. Do not append the $D symbol to this environment variable.
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Refer to Using the Custom Directory on page 30 for more information.

Testing Your Customizations

After incrementally migrating your customizations to this version of Arbortext
Editor, thoroughly test the functionality. This is especially important in the areas of
custom document types, profiling, and publishing for HTML and web.

Once you have successfully tested your customizations, move your Arbortext
Editor installation to your production environment.
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Windows Installation Alternatives
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This chapter contains information on alternative ways to install Arbortext Editor.
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Installation Alternatives

Depending on your site's specific needs, you might want to perform one or more of
the operations listed in this chapter. These operations can facilitate the installation
process. You might want to:

Share the entire distribution archive from a Windows network. Users can then
install the software from their remote Windows systems.

Perform a Windows Active Directory installation for systems on a Windows
network.

Develop a compact installation for Arbortext Editor for users to download.

If necessary, install or update the FlexNet license server. Sites that have
floating licenses should install the license server before setting up individual
users.

If none of these alternatives apply to your site, skip to Standard Installation
Procedure on page 41.

Installing on Microsoft Windows Vista and

7

The security features of Microsoft Windows Vista and Windows 7 can affect the
Arbortext Editor install, uninstall, or licensing processes. Please be aware of the
following issues when using Microsoft Windows Vista and Windows 7:

34

When you install Arbortext Editor on Microsoft Windows Vista and Windows
7, a User Account Control dialog box appears asking whether you want the
installation to proceed. Select Allow to proceed with the install process. The
dialog box is displayed even when you are logged on with administrator
privileges.

When using the msiexec to install or uninstall Arbortext Editor, you must
use an elevated command prompt.

When you uninstall Arbortext Editor from the Microsoft Windows Vista and
Windows 7 Control Panel, a User Account Control dialog box appears stating
that An unidentified program wants access to your computer. Select Allow to
proceed with the uninstall process.
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Developing a Compact Installation

Besides the full installation of Arbortext Editor, you can also develop a compact
installation that users can download from a web site or network share. A compact
installation enables you to have a centralized location for any Arbortext Editor
configuration or customizations required for your site.

The compact installation of Arbortext Editor is much smaller than the full
installation and has somewhat less functionality. It is more appropriate for
authoring, than developing customizations, custom document types, and so forth.
The compact installation has the following significant differences in functionality
from the full installation:

* Publishing requires Arbortext Publishing Engine.
* File » Print Preview produces a PDF file and requires Adobe Reader.

* File » Print also produces a PDF file and requires Adobe Reader.

The PDF file must be printed from Adobe Reader.
» The Arbortext Help Center might not be available.

The Help Center is an optional addition to the compact installation. If the Help
Center is not available, the compact installation contains an HTML Help file
with the Arbortext Editor and Arbortext Styler online help.

Developing a compact installation of Arbortext Editor requires several steps. First,
you must determine the optional features you want to include in the installation
and develop a Deploy Directory to hold the installation files associated with both
those and the required features. The Deploy Directory must be hosted on a web
server or network share that your users can access. Next, you must create a custom
installer tied to the Deploy Directory to distribute to users. This installer is much
simpler than the regular Arbortext Editor and presents fewer choices to the users. It
1s up to administrators to develop a compact installation that contains the correct
feature set for their users. Finally, you must make the Deploy Directory and custom
installer available to users. Note that a user must have administrator privileges on
their system to install the compact installation.

An Arbortext Editor Deployment Kit is available to assist you with the
development of a compact installation. For more information, refer to the
Arbortext Editor Deployment Kit Guide.
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Performing a Windows Active Directory
installation

You can use the Windows Active Directory to install the distribution on multiple
systems. You can base the installation on either the computers or users on your
network. Refer to the Microsoft Windows Active Directory documentation for
more information about performing an Active Directory installation.

Before performing the Active Directory installation, you can use an MSI file
editor, such as the Windows Orca editor, to modify the properties in the Windows

installation file (Arbortext .ms1) to match the requirements of your

environment. Refer to the following web site for more information about the Orca

editor:

msdn2.microsoft.com/en-us/library/aa370557.aspx

Following are the properties (from the Property table) you can modify in the
installation file, grouped by the installation dialog box on which they appear.
Beside of each property in parenthesis is the default value for the property in the
installation file. For properties that are either on or off, set the property to any
value that does not start with the letter N or n to turn the property on. To turn a
property off, there are two options. If the default is off, do not set the property at
all. If the default is on, set the property to a value that starts with the letter N or n
(for example, no) to turn the property off. Note that properties that are off by
default may not appear in the default Property table.

* Products dialog box

O

O

O

O

INSTALL EDITOR (on)
INSTALL STYLER (off)
INSTALL ARCHITECT (off)
INSTALL DESKTOP ICONS (on)

* File Types dialog box

O
O

O
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ASSOC_ACL (on)
ASSOC_SGM (on)
ASSOC_ XML (on)
ASSOC_DCF (on)
ASSOC_MCF (on)
ASSOC_FOS (on)
ASSOC_STYLE (on)
ASSOC_DITA (on)
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* Help Center Languages dialog box

O INSTALL HELPCENTER EN (on) — English

© INSTALL HELPCENTER FR (off) — French

© INSTALL HELPCENTER DE (off) — German

© INSTALL HELPCENTER IT (off) — Italian

O INSTALL HELPCENTER ES (off) — Spanish

O INSTALL HELPCENTER_JPN (off) — Japanese

© INSTALL HELPCENTER KOR (off) — Korean

© INSTALL HELPCENTER CHS (off) — Simplified Chinese
O INSTALL HELPCENTER CHT (off) — Traditional Chinese

Note that if the operating system locale is not English, the translated
documentation corresponding to that locale will also be set to on.

» Destination Folder dialog box

O INSTALLDIR(C:\ProgramFiles\Arbortext\Editor)

*  Products dialog box
© SETUP TYPE (Typical)

The allowed values for this property are Typical, Complete, and Custom.
If you set this property to Complete, all of the optional product features will
be installed. If you set this property to Custom, you can set the following
additional properties for optional product features:

© INSTALL SMA APPLICATION (on)
© INSTALL DLM (off)
© INSTALL TIMPORT EXPORT (off)

© INSTALL IMPORT WORKBENCH (on when Arbortext Architect is
included in the installation, off otherwise)

© INSTALL PRINT COMPOSER (on when Arbortext Styler is included in
the installation, off otherwise)

© INSTALL PTC SERVER CONNECTION (on)

© INSTALL WEB WIRELESS COMPOSER (on when Arbortext Styler is
included in the installation, off otherwise)

© INSTALL DOCUMENTUM (off)

© INSTALL DOCUMENTUM WDK (off)
© INSTALL DOCUMENTUM XML (off)
© INSTALIL_ IBMDM (off)
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© INSTALL ORACLE CM SDK (off)
* Using Arbortext Publishing Engine dialog box
© USING PE (off)

If you set the value of this property to on, then you must enter the URL for
your Arbortext Publishing Engine server in the PE_SERVER URL
property or the Arbortext Publishing Engine will be unable to publish your
documents.

O PE_SERVER_URL (null)
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This chapter provides the standard installation procedures for Windows systems.
This version is a full installation; no previous version of Arbortext Editor is
required.

If you are replacing or upgrading from a previous installation, you should refer to
Software Upgrade Considerations on page 26.

You will need to obtain updated licenses for this release. You can enter licensing
information the first time you run Arbortext Editor. Your system administrator may
deploy some licensing information telling you how to enter the licensing
information. Refer to Obtaining Licenses on page 54 for information.
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Installation Overview

To install your Arbortext software, you will need:

The distribution DVD or the archive file you downloaded from the PTC
support site.

First, determine if you want the 32 or 64-bit versions of the software. If you are
downloading an archive file from the PTC support site, you have to choose
which version of the archive file you want to download. If you are installing
from the distribution DVD, the installation program asks you which version of
the software you want to install.

A list of the product options that your site has purchased.

If you are installing the Arbortext Adapter to Documentum, you will need to
know the location of your Documentum client software installation.

The Documentum client software must be installed and working correctly
before you install the adapter. Each user will need access (using the system
path or Documentum-specific environment variable) to the Documentum client
software initialization file dmcl.ini.

If you are installing the Arbortext Adapter to Documentum/XML, the
Documentum client software must be installed and working correctly before
you install the adapter.

To install your Arbortext software perform the following steps:

I.

40

Make any necessary preparations before installation, such as making the
installation files available on a server. See Installation alternatives on page 34
for more information.

Install the software and product options.

Note

You must have administrator privileges to install Arbortext software on
Windows systems.

Customize your licensing parameters if necessary.

If you installed a repository adapter, perform the necessary procedures to
connect the repository adapter to your document repository.

Check the PTC Customer Support web site at www.ptc.com/support/support.
htm for software updates that may apply to your installation.
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Standard Installation Procedure

To install the Arbortext Editor software:

1. Start the Arbortext Editor setup program. Use the startup instructions that
match your specific situation.

Installing from a release file downloaded from the support site:

Unzip the file containing the release to a temporary directory on your local
system (for example, C:\ Temp). Select Run from the Start menu, browse
to the temporary directory where you unzipped the release and locate the
\windows\ setup.exe program.

The setup program first asks you to select the language for your
installation.

Select a language from the drop down list and click OK to continue the
installation.

Installing from the distribution DVD:

Insert the DVD in the DVD drive. The setup . exe program will run
automatically.

Note

If AutoRun is disabled, you can select Run from the Start menu, browse to
the drive for your DVD, and run the setup . exe program.

When you are installing from the DVD, the setup program displays the
following initial dialog boxes:

a. The setup program asks you to select the language for your
installation.

Select a language from the drop down list and click OK to continue the
installation.

b. The setup program asks you to select either the 32 or 64-bit version
of the software.

Select the version of the software you want to install and click Next to
continue the installation.

You also have the option to explore the contents of the DVD.

Installing from a network server:

Select Run from the Start menu, browse to the network drive and locate the
\windows\ setup.exe program.

2. The setup program displays a Welcome dialog box.

Click Next to continue the installation.
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The setup program prompts you to accept the license agreement.

The license agreement is presented in the language you choose for the
installation. You have the option to view the license agreement in another
language.

Click Accept to continue the installation.

The setup program prompts you for the products to install.

You can install one or more products at a time. If you select more than one
product, they will all be installed in the same location. You can also indicate
whether you would like to create desktop icons for the installed products.

Select the appropriate products and indicate whether you would like to create
desktop icons for them, then click Next to continue the installation.

The setup program prompts you to choose whether to make an association
for the following file types and your new Arbortext Editor installation:

* Arbortext Command Language File (acl)
*  SGML Document (sgm)

* XML Document (xml)

*  Doctype Configuration File (dcf)

» Arbortext Macro File (mcf)

* FOSI Stylesheet (fos)

» Styler Stylesheet (style)

* DITA Documents (dita, ditamap)

Select the appropriate file associations, then click Next to continue the
installation.

The setup program prompts you to select the localized documentation you
would like to include in the Arbortext Help Center.

Select any languages you would like to include, then click Next to continue the
installation.

The setup program prompts you to specify an installation folder.

You can accept the default location or select Change to specify a different
location. If you specify a nonexistent folder, the setup program will create it
for you.

Specify the appropriate destination folder, then select Next to continue the
installation.

The setup program prompts you to select one of the following setup types for
your installation:
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Typical — For an Arbortext Editor installation, installs the Service Manual
Application and PTC Server connection features. For an Arbortext Editor

with Styler installation, also installs the Print Composer and Web/Wireless
Composer options and a subset of the Import/Export feature. For an

Arbortext Architect installation, also installs the Import Workbench feature.
Complete — All optional features will be installed.

Custom — Opens the Custom Setup dialog box, from which you can select
the features you want to install.

The Custom Setup dialog box enables you to choose from the following
product features:

The Dynamic Link Manager feature is an optional feature that is available
with Arbortext Publishing Engine. The Arbortext client software also
requires installation of DLM components.

The Import/Export feature installs the Arbortext Import/Export product
option. This feature requires an additional license. Refer to the
Arbortext Customizer's Guide for instructions on configuring and using
Arbortext Import/Export.

The Import Workbench feature is also part of the Arbortext Import/Export
product option and requires an additional license. This feature requires the
installation of the latest version of .NET.

The Print Composer feature installs the Arbortext Print Composer product
option. This product option prepares your documents for print publishing
and requires an additional license. Note that the Print Composer option is
required to support Arbortext Publishing Engine publishing.

The Service Manual Application feature installs the Service Manual
Application. The Service Manual Application provides a customized
editing and publishing environment for authoring service manuals. The
Service Manual Application is based on the DITA standard.

The Web/Wireless Composer feature installs the Arbortext Web/Wireless
Composer product option. This product option requires an additional
license.

The PTC Server connection feature installs the PTC Server connection. The
PTC Server connection provides an interface between Arbortext Editor and
either Arbortext Content Manager, Windchill PDMLink, or Windchill
ProjectLink.

The Optional Adapters feature can be customized. Click on the “+” next to
Optional Adapters to open the list of optional repository adapters. Select the
optional adapters you want to install from the list:
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The Arbortext Adapter to Documentum feature installs the Arbortext
Adapter to Documentum product option. The adapter provides an
interface between Arbortext Editor and the Documentum Server and is
used to manage SGML content in Documentum. The instructions on
configuring and using the Arbortext Adapter to Documentum appear in
the Arbortext Content Management Guide. This product option does
not require an additional license.

Note that this option is not available in the 64-bit version of the
software.

The Arbortext Adapter to Documentum/WDK feature installs the
Arbortext Adapter to Documentum/WDK product option. The adapter
provides the behavior of the Arbortext Adapter to Documentum/XML
without requiring that the Documentum Desktop be installed on each
workstation. The instructions on configuring and using the Arbortext
Adapter to Documentum/WDK appear in the

Arbortext Content Management Guide. This product option does not
require an additional license.

The Arbortext Adapter to Documentum/XML feature installs the
Arbortext Adapter to Documentum/XML product option. The adapter
is an interface between Arbortext Editor and the Documentum eContent
Server. The instructions on configuring and using the Arbortext
Adapter to Documentum/XML appear in the

Arbortext Content Management Guide. This product option does not
require an additional license.

Note that this option is not available in the 64-bit version of the
software.

The Arbortext Adapter to IBM Document Manager feature installs the
Arbortext Adapter to IBM Document Manager product option. The
Arbortext Adapter to IBM Document Manager provides an interface
between Arbortext Editor and an IBM DB2 Document Manager server.
The instructions on configuring and using the Arbortext Adapter to
IBM Document Manager appear in the

Arbortext Content Management Guide. This product option does not
require an additional license.

Note that this option is not available in the 64-bit version of the
software.

The Arbortext Adapter to Oracle CM SDK feature installs the Arbortext
Adapter to Oracle CM SDK product option. The Arbortext Adapter to
Oracle CM SDK provides an interface between Arbortext Editor and an
Oracle CM SDK server. The instructions on configuring and using the
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Arbortext Adapter to Oracle CM SDK appear in the
Arbortext Content Management Guide. This product option requires an
additional license.

Clicking Space on the Custom Setup dialog box opens another dialog box
showing the available disk space on your system.

Select the appropriate setup type for your installation, then click Next to
continue the installation.

If you selected Arbortext Architect as a product to install, the setup program
asks whether you would like to install Turbo XML. You can elect to install
Turbo XML as an alternative to the text-based DTD Editor in Arbortext
Architect.

If you elect to install Turbo XML, the setup program will start the separate
installation program for Turbo XML after your Arbortext installation is
complete. The setup program will configure Arbortext Architect to use Turbo
XML when editing XML DTDs and schemas.

Indicate whether you want to install Turbo XML, then click Next to continue
the installation.

The setup program asks whether you will be using the Arbortext Publishing
Engine for document publishing. Check the box if you will be using Arbortext
Publishing Engine. If so, you also have the option to enter the URL for your
Arbortext PE server. It will have the following format:

http://servername:portnumber/e3/servlet/e3
Click Next to continue the installation.

The setup program indicates it is ready to install the program.

Click Install to continue the installation. The setup program displays the
status of the installation.

The setup program indicates the installation is complete.

If you elected to install Arbortext Architect and Turbo XML, the setup program
will start the Turbo XML installation program. You will need to reboot your
system when the Turbo XML installation is complete.

Product Option Configuration on Windows

Product options are installed with the Arbortext Editor setup program and are
stored in your Arbortext Editor installation directory. Available product options
include:
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» Arbortext Print Composer

* Arbortext Web/Wireless Composer

* Arbortext Import/Export

*  Turbo XML

» Arbortext Adapter to Documentum/XML

* Arbortext Adapter to Documentum/WDK

* Arbortext Adapter to Documentum

* Arbortext Adapter to IBM Document Manager
* Arbortext Adapter to Oracle CM SDK

The availability of a given product option depends on the following:

* The product option must be installed. You can use the Arbortext setup
program to install any of the product options at any time.

* The product option must be set on in the Arbortext-path\ 1ib
\installprefs.acl file. (Arbortext-path is where Arbortext Editor
is installed.) The setup program automatically turns on the product options
you've installed.

» The license for the product option must be available from the license manager.

Depending on the product options you installed and licensed, you may need to
perform additional procedures to configure your product options.

Customizing the installprefs.acl File (Optional)

The Arbortext-path\ 1ib\ installprefs.acl file stores the “on” or
“off” status of each of the Arbortext Editor product options. Each line in the
installprefs.acl fileis an Arbortext Command Language (ACL) set
command for a specific product option. Each of these set commands is
documented in the Arbortext Command Language Reference.

While the setup program creates the initial settings in this file, you may need to
editthe installprefs.acl file for your site's specific needs. For example, if
you have Arbortext Editor installed on a server for client access, all clients will use
the installprefs.acl file from the server's installation directory. If you want
certain clients to have specific product option settings, you will need to customize
your installprefs.acl file.

Determine the features that should be available. Copy the default
Arbortext-path/lib/installprefs.acl file, and edit the set
feature commands accordingly.
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Do this for each client-specific or group-specific set of features you want enabled.
If you wish, you can rename the file (for example, doc _installprefs.acl or
sales installprefs.acl).

You can make custom installprefs.acl files automatically available by
putting it in the user's Arbortext-path\ custom\ 1ib directory to load it
automatically upon startup (avoiding the need to set an environment variable).
Refer to Description of the custom directory structure in the Arbortext Help Center
for more information.

You can set the APTINSTALLPREFS environment variable to the path and file
name of the custom installprefs.acl file for each client or group. Navigate

to the Advanced tab of the System Properties dialog box and choose the
Environment Variables button.

Configuring Repository Adapters

If you installed a repository adapter, you will need to configure it before you use
Arbortext Editor with your repository.

* For instructions on configuring the Arbortext Adapter to Documentum/XML,
refer to the Installing and configuring the Arbortext Adapter to Documentum/
XML in the Arbortext Content Management Guide.

* For instructions on configuring the Arbortext Adapter to Documentum/WDK,
refer to the Installing and configuring the Arbortext Adapter to Documentum/
WDK in the Arbortext Content Management Guide.

» For instructions on configuring the Arbortext Adapter to Documentum, refer to
the Arbortext Adapter to Documentum configuration overview in the
Arbortext Content Management Guide.

+ For instructions on configuring the Arbortext Adapter to IBM Document
Manager, refer to the Configuring the adapter topic in the Arbortext Adapter to
IBM Document Manager section of the Arbortext Content Management Guide.

» For instructions on configuring the Arbortext Adapter to Oracle CM SDK,
refer to the Arbortext Adapter to Oracle CM SDK configuration overview. The
installation instructions for the Arbortext Adapter to Oracle CM SDK servlet
(which is installed on your CM SDK host) are located in the
Arbortext Content Management Guide and on the Arbortext Editor distribution
archive within the /server/oracleifs/oracleifs.tar and
\ server\oracleifs\oracleifs.zip archives.
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Licensing Options for Arbortext Software

Your Arbortext software needs either a node-locked FlexNet license or a floating
FlexNet license to run. Arbortext software licenses are available online for
customers covered by an active maintenance agreement. You must have a PTC
online account and a Customer Number to get a license. If you do not already have
one, you can establish a PTC online account at www.ptc.com/support/support.htm.

There are three basic types of licenses:

* A node-locked license for use on a single computer. This type of license is
usually obtained by the end user.

* A floating license pack for a single computer that will be serving floating
licenses to end users. This type of license is usually obtained by a system
administrator.

* A floating license pack for a set of three servers (called a triad license server)
that will be serving floating licenses to end users. This type of license is usually
obtained by a system administrator.

Be sure to read Requesting Licenses on page 54 for more information. Licensing
information is stored on the user’s system in an environment variable, regardless of
the type of license. Refer to PTC D LICENSE FILE Environment Variable on
page 57 for information.

It’s possible that a system administrator will deploy the licensing information to
your computer (which is stored in the PTC_ D LICENSE FILE environment
variable), and you may never be prompted for the information unless you
encounter a problem. Refer to Windows Installation Alternatives on page 33 for
more information.

Node-Locked Licenses

A node-locked license is a local license file that allows Arbortext products to run
on an authorized computer. The license file itself is stored on the computer.
License files are generated from a Host ID code unique to each system. You can
run an unlimited number of instances of Arbortext software on one authorized
computer.

The PTC licensing web site uses your Arbortext software selection and version,
customer number, and Host ID code to generate a node-locked license for the
specified software.
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Floating Licenses

Floating licenses are made available from a license server on a network to a set of
users running the software. A license server allows multiple computers (license
clients) on the network to run Arbortext software concurrently. The client
computers running Arbortext software must specify the port and server name of the
license server to obtain a floating license. If a license is available, the user is
allowed to run the application.

The PTC licensing web site uses the Arbortext software selection and version,
customer number, and Host ID code of the license server or servers to generate
floating licenses for the specified software.

Your system administrator must install the FlexNet license management software
and set up the necessary floating licenses before users can run their Arbortext
products. See the instructions in Installing and Updating the License Server on
page 56.

A single-server configuration uses only one computer as the license server. Your
site can implement server redundancy by using a triad license server. A triad server
configuration uses three license servers. A triad server provides a fallback
mechanism for Arbortext products to obtain licenses even if the main server goes
down. Because a majority rule is in effect, at least two of the servers must be
running for the triad server to function.

When you run Arbortext software with a floating license, you may need to specify
the communications port number and license server name the first time you run the
software. If prompted, you would enter the server information in the form
port@servername; for example, 6789@aberdeen.

You should verify the following with your network administrator:

» The FlexNet license server software has been installed and configured on the
license server machine.

* The port number and server name of the license server on your network.

The FlexNet license management software and installer program are in the
flex1m folder on the Arbortext software DVD or the license server download zip

file available from the PTC Support site. Go to Order or Download Software
Updates and find PTC License Server: FLEXnet Publisher. Choose the latest

version of the download file for your system. The license server installation
instructions are located at:

http://www.ptc.com/appserver/wems/standards/freefull cskdb.jsp?
&im_dbkey=90870&im_language=en
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After the FlexNet software is installed, it must be configured to recognize the client
computers as floating license clients. Consult the FLEXnet Licensing End User
Guide in the f1ex1m directory for license management software setup and
configuration instructions. You can also download this guide from the Reference
Documents section on the PTC Support site at:

http://www.ptc.com/support/

Using Both License Types

Occasionally, someone may want to use both license types (either a node-locked
license or a floating license) to enable Arbortext software to run. The application
can search for both node-locked and floating licenses when attempting to obtain a
license.

You must enter the information to locate both types of licenses, meaning the
license file path for the locked license as well as the port@servername
specification for the floating license server.

The values for both types of licenses are stored in the PTC_D LICENSE FILE
Environment Variable on page 57.

Licensing Prerequisites

To configure license(s) and obtain a license pack file, you need the following:

*  Web access and a PTC customer account with an active maintenance
agreement. You can register at http://www.ptc.com/support.

* Your customer login, password, and customer number for the Arbortext
software you want to install.

* The Host ID code unique to the computer. You can get the Host ID in any of
the following ways:

O the first time you run the Arbortext software, if it can’t obtain a license. A
licensing dialog box will prompt for the information. Some users may not
have to enter this information if their license administrator has already
deployed license information to their computers.

O by running cpu_id.exe from a Windows command prompt (available
from the f1ex1m directory on the installation DVD or download zip or
from the PTC support site).

O by going to the following web page on the PTC support site for
instructions:

http://www.ptc.com/appserver/wems/standards/freefull cskdb.jsp?
im_dbkey=90575&icg dbkey=900
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Node-Locked License Prerequisites

For each copy of Arbortext software you plan to install, you need to:

Request a license on the PTC Support site at http://www.ptc.com/support. Have
your customer login, password, customer number, and Host ID for the
computer at hand.

If you are setting up a floating license server, be sure you have the Host ID and
server name of the license server or servers (for a triad).

See Requesting Licenses on page 54 for instructions.

Receive the license pack file containing your configured license(s). The license
pack file is a text file attached to an email from PTC License Management
(LM@ptc.com). Save the attached license pack file to a folder on the computer
where you will install your licenses.

See Receiving Your License Pack on page 56 for instructions.

Floating License Prerequisites

The following prerequisites apply if you plan to install a license server to provide
floating licenses:

The floating license server must have the FlexNet license management
software installed on it.

The FlexNet license management software and installer program are in the
flex1m folder on the Arbortext software DVD or the license server download

zip file available from the PTC Support site. Go to Order or Download Software
Updates and find PTC License Server: FLEXnet Publisher. Choose the latest

version of the download file for your system. The license server installation
instructions are located at:

http://www.ptc.com/appserver/wems/standards/freefull cskdb.jsp?
&im_dbkey=90870&im_language=en

Install this software on the license server. See the FLEXnet Licensing End User
Guide for setup and configuration instructions. (Installing FlexNet license
management software requires administrator privileges on the license server
computer.)

Your Arbortext software must have a working network connection to the
license server and specify the port number and server name to request licenses.
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Obtaining Licenses

You will need to obtain a new license for the Arbortext Editor 6.0 release.
Beginning with Arbortext Editor 6.0, these licenses are backward compatible. This
means that you must update your license each time you upgrade to a major
Arbortext Editor FOOO release (maintenance releases or datecode updates would
not require a license update). Licenses requested for the next major release of
Arbortext Editor after version 6.0 would still work for users running Arbortext
Editor 6.0. For example, if the next major release is Arbortext Editor 6.1, a license
issued for that version would be compatible with both 6.1 and 6.0.

Licenses issued for previous releases (such as 5.4) will not work with Arbortext
Editorr 6.0, but older versions of Arbortext Editor will continue to work with the
license keys issued for them.

What You Will Need

When you obtain your license, you will need your PTC support site login
information and customer number for the www.ptc.com/support/support.htm. You
will also need the Host ID of the client (for a node-locked license) or server (for
floating licenses) computer. Refer to Requesting Licenses on page 54 for further
information.

The PTC support web site might not offer license keys for all possible customer
requests. Ask for assistance on the PTC Customer Support web site, if necessary,
regarding any of the following:

* Modification of an existing license key to add new floating licenses to an
existing server.

» Extension of a temporary license for evaluation.

* Generation of licenses for triad server configurations.

You can submit a request for help on the PTC Customer Support at www.ptc.com/

support/support.htm by choosing Log a New Call under Popular Tools or Customer
Care Call Logger under Customer Care. You can also contact PTC License

management support by telephone. See www.ptc.com/olm/contacts for a list of
contact numbers.

Requesting Licenses

Read the License Management chapter in your PTC Customer Service Guide
before you start configuring Arbortext licenses. The general instructions in that
chapter will prepare you for the licensing instructions that follow.

Also, be sure you’ve read Licensing Options for Arbortext Software on page 50.
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On the PTC Support web site, the licensing web tool steps you through the process
of configuring your software to your hardware. You need a PTC.com web account

login, your Customer Number, and your Host ID code unique to the computer. You
can get the Host ID:

 the first time you run the Arbortext software, if it can’t obtain a license. The
Licensing Error dialog box will prompt for license source information and

provide the Host ID for the system.

* by running cpu id.exe from a Windows command prompt (available from
the £1ex1m directory on the installation DVD or download zip or from the
PTC support site).

* by going to the following web page on the PTC support site for instructions:

http://www.ptc.com/appserver/wems/standards/freefull cskdb.jsp?
im_dbkey=90575&icg_dbkey=900

It’s possible that your system administrator has deployed the licensing information
to your computer (which is stored in the PTC_D LICENSE FILE environment
variable), and you may never be prompted for license information unless you
encounter a problem. Refer to Windows Installation Alternatives on page 33 for
more information.

You will use the PTC License Landing Page to configure the Arbortext software
licenses for your hardware.

1. Go to the PTC support page at http://www.ptc.com/support.
2. Choose Arbortext .

3. Choose Licensing.
4

Choose Arbortext License Support and log in to your PTC account when
prompted. You will need your login name, password, and Customer Number.

Choose your Product Family from the list.
Choose the Version from the list. The Hardware Selection is then displayed.

Enter the PTC Host Id (available by following the directions at the beginning of
this section). If your computer is already in the system, you can Browse for it.

Enter the name for your computer in the Host/Triad Name.
The PTC Host Id and Host/Triad Name identify one of the following:
* A single computer for a node-locked license.

* A single computer that will be serving floating licenses to end users.

* A set of three computers (called a triad license server) that will be serving
floating licenses to end users. This type of licensing provides server
redundancy.
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Click Continue.

8. If'the Host ID is not in the PTC licensing system, you will be asked to enter an
installation address and contact that will be associated with the Host ID.

9. Confirm the combination of Arbortext software and your hardware for your
license. Then click Get License. You will get a call number for confirmation of
the request.

The license transaction is processed and the license file will be emailed to you,
usually within 10 minutes.

Receiving Your License Pack

After you have finished Requesting Licenses on page 54, a license pack file will be
sent to you by email from LM@PTC.com. The attached license pack is a text file
with a file name of the form Im xxxxxxxx standard.txt. The email
message may contain licensing instructions for other PTC software products,
depending on the content of the license pack file. Save the attached license pack
file to a temporary location and note its location.

If you are using a locked license, you will be prompted to enter the license file
location the first time you run Arbortext software. The information is stored in the

PTC D LICENSE FILE Environment Variable on page 57. It’s available from the
User variables or System variables list on the Environment tab of your System
Properties dialog box.

If you will be using a floating license but you are not configuring a license server,
you will not be obtaining a license from PTC. You will instead enter the port
number and server name the first time you run the software. See Licensing Options
for Arbortext Software on page 50 for information on license types.

Installing and Updating the License
Server

If you are upgrading from a previous version of Arbortext software for the first
time, and your installation uses floating licenses or a combination of node-locked
and floating licenses, your license administrator will need to install the FlexNet
License server. If a user attempts to use an upgraded version of the Arbortext

software with an unsupported license server or an invalid license file, the Licensing
Error dialog box displays the error and prompts for valid license information. If the

FlexNet license server is already installed, it may not need to be upgraded when
the Arbortext software is upgraded. Please refer to the Release Notes for your
particular version for more information.
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The FlexNet license server system is documented in the FlexNet Licensing End
User Guide. This guide explains the basics of FlexNet floating (network) licensing,
gives an overview of the FlexNet licensing components, and provides details on
managing floating licenses for administrators. This guide is available from the
flex1m directory of the Arbortext installation distribution (either from the DVD
or zip download) and also from the Reference Documents web page of the PTC
Support site at http://www.ptc.com/support/.

The FlexNet license management software and installer program are in the
flex1lm folder on the Arbortext software DVD or available in the license server

download zip file from the PTC Support site. Go to Order or Download Software
Updates and choose PTC License Server: FLEXnet Publisher. Choose the latest

version of the download file for your system.

For instructions on installing the PTC FlexNet License Server as either a single
server or a triad server, refer to the following Suggested Technique:

http://www.ptc.com/appserver/wems/standards/freefull cskdb.jsp?
&im_dbkey=90870&im_language=en

For more general information on floating licensing, see Licensing Options for
Arbortext Software on page 50.

PTC D LICENSE FILE Environment
Variable

Be sure you have read Licensing Options for Arbortext Software on page 50 and
Requesting Licenses on page 54.

Arbortext software looks for the PTC_D LICENSE FILE environment variable
automatically when it starts. This variable setting provides the path to your node-
locked license file or the port@servername specification where your software
should retrieve a floating license. When you run Arbortext software for the first
time, it checks for a valid license source in PTC_D LICENSE FILE. Ifit does
not exist or has an incorrect value, you will need to specify it.

If you need to add or reset PTC_D LICENSE FILE, choose from the following:

* For a node-locked license file, set its value to the license file path.

* For a single floating license server, set its value to port@servername, for
example, 6789@aberdeen.

» For a triad server configuration, set its value to:
port@servernamel, port@servername?2, port@servername3

For example:
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3456@able, 3456R@baker, 3456Qcharlie

» For a combination of node-locked and floating licenses, you would set its value
to both the license file path and the port@servername. Note that each type
of license option is separated by a semicolon (; ). For example:

C:\User Data\All Users\Application Data\Arbortext\
Im 12345678 standard.txt;3456Cable, 3456@baker, 3456@charlie

It’s possible that your system administrator has deployed the licensing information
to your computer (which is stored in the PTC D LICENSE FILE environment
variable), and you may never be prompted for the information unless you
encounter a license problem. Refer to Windows Installation Alternatives on page
33 and Licensing Error dialog box for more information.

Borrowing a License

If your site uses floating licenses, you may also be able to run Arbortext Editor
while you are away from the network. Your FlexNet license server must have
license borrowing configured and enabled. You can borrow a license for specific
products and options to which you are entitled to have a license, and you can
choose the time period up to the maximum allowed.

To borrow a license to work offline, choose Tools » Administrative Tools » Borrow
Licenses to launch the Borrow Licenses dialog box. From the list of Available

licenses, you can highlight your choice and then set a duration period. Click the
right arrow to move the license option to the Borrowed list. It appears as (Pending)
until you click Apply, when the license request is sent to the license server.

If you expect to be able to borrow a license and encounter a problem, contact your
license administrator to be sure:

* Your system is looking for the correct license server. Ask your system
administrator for the correct value for the PTC D LICENSE FILE
Environment Variable on page 57 on your system.

» License borrowing is enabled on the license server.

* The license server is configured to allow your client machine to obtain a
borrowed license.
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Troubleshooting Licensing Problems

Unable to Obtain a License

Arbortext users must have an active maintenance agreement, a PTC online account
login and password, and a Host ID to get a license. Go to www.ptc.com/support/
support.htm. to obtain a license. Refer to Requesting Licenses on page 54 for more
information.

Arbortext products display the Licensing Error dialog box when a license can’t be
found. There are a wide variety of reasons that your software can’t obtain a license.
For floating licenses, the more common error messages may report that the license
server is down or that all licenses are in use. If so, you should wait a few minutes
and try again. If the problem persists, contact your license administrator. For node-
locked licenses, the error message may report that the path to the license file is not
valid. If so, you will need to locate the license file and update the path.

Licensing information is stored in the PTC D LICENSE FILE Environment

Variable on page 57. If it isn’t defined correctly or isn’t defined at all, the Licensing
Error dialog box will prompt you to enter the correct licensing information.

Node-Locked License Problems

Check whether you have the correct path for your license file. Locate your license
file and compare its location with the path specified in the Licensing Error dialog
box or the PTC_D LICENSE FILE environment variable.

Floating License Problems
If you are unable to obtain a floating license, investigate the following:

»  Check whether you have the correct license server port number and server
name (or three consecutive servers if your site is using a triad license server).
Ask your license administrator for the correct value for the license server and
enter it in the Licensing Error dialog box.

* Contact your system administrator and ask if the license server is running.

+ Ifyour site is using a triad license server, and the first license server goes
down, licenses might be unavailable for a few minutes until the backup servers
start distributing licenses. Wait for a few minutes and restart your Arbortext
software. If you receive the same message, contact your system administrator
and ask if the triad server is running.
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Unable to Renew a Floating License

If your Arbortext software session is inactive for a long period of time, the license
manager (which serves floating licenses) may take back your license based on the
FlexNet license server’s TIMEOUT (ALL) configuration setting. If all available
licenses are in use by other users when you resume your Arbortext software
session, you will see an error message. The FLEXnet Licensing End User Guide,
which explains the TIMEOUT (ALL) setting as well as other configuration
settings, should be reviewed carefully by the license administrator.

This message might also appear if you are using a system in a remote location and
connected to the license server over a VPN or dial-up connection. You may need to
re-establish your connection before you can continue to use your Arbortext
software. In such cases, license borrowing may be a more effective strategy. Refer
to Borrowing a License on page 58 for more information.
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